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1 Overview 


The Biology Standard Operating Procedure (SOP) manual specifies procedures for routine 
examinations and analyses of biological evidence for human identification.  It is approved for 
use in the Biology section of the laboratory.  Within the scope of that purpose, it is intended to 
ensure effective and efficient use of the laboratory facilities for the benefit of all user agencies.  
It incorporates the quality assurance elements necessary to ensure the reliability and uniformity 
of analyses and reported conclusions.  


Each approved revision of this manual will be version-controlled and archived for retrieval by 
date of authority.  Only the approved revision in effect at the time of analysis governs the 
analysis.  The official version of this controlled document shall be published on the laboratory’s 
intranet webpage and can be viewed from network computers.  Any deviation from accepted 
protocol requires approval as outlined in the Methods section of the quality manual, and must be 
documented in the case file. 


This SOP is only one part of the policies and procedures that govern all work performed by the 
Biology section.  The Biology section will follow the requirements detailed herein, in addition to 
the following: 


• Houston Police Department General Orders 


• Houston Police Department Crime Laboratory Quality Manual 


• Houston Police Department Crime Laboratory Safety Manual 


• Houston Police Department Crime Laboratory Biology Training Manual 
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2       Facilities 
 


2 Facilities 
The Biology section will be designed to provide adequate space and setup to perform casework 
analysis.  General facility requirements are described in the Quality Manual. 


2.1 Work Areas 


The Biology section will have space for evidence examination.  The tasks performed in this area 
can include: blood and semen fluid identification, swab collections, cutting of stains, portioning 
of swabs and cuttings, microscopy and trace evidence collection. 


2.2 Contamination 


With the facility provided, setup and procedures will be designed to minimize the potential for 
DNA contamination.  Traffic in and through areas in which testing occurs will be minimized. 


Prevention and Decontamination 


10% bleach, or DNA Away where bleach may be harmful to instruments or equipment, will be 
used to decontaminate utensils and workbenches.  Other commercial decontaminants may be 
used only if they have been demonstrated to destroy or inactivate DNA. 


Wear disposable gloves during all testing and reagent preparation.  Change gloves frequently 
and whenever gloves may have become contaminated.  Discard gloves when leaving a work 
area. Use sterile, disposable pipette tips and microcentrifuge tubes. Change pipette tips 
between samples. Centrifuge all liquid to the bottom of closed microcentrifuge tubes before 
opening. 


Clean work surfaces in the evidence examination areas thoroughly with a lab-approved 
decontaminant prior to and at the end of each evidence examination session.  Use disposable 
bench paper whenever possible and change each time it comes in contact with evidence. Use a 
clean cutting surface such as weighing paper or piece of paper for evidence.  Protect supplies of 
this paper from dust and other particulates or aerosols. Clean instruments (e.g., scalpels, 
scissors, forceps) with decontaminant between evidence samples. To prevent contamination of 
other standards or evidence, handle each piece of evidence one at a time.  Liquid samples, 
such as blood standards, and wet exhibits shall be allowed to air dry in a method that it will not 
come into contact with other pieces of evidence.  


Wear gloves when cleaning glassware and plastics.  In general, clean glassware/plastics with 
an appropriate soap, e.g., Liquinox or Alconox, and water.  Rinse with deionized or distilled 
water and allow to air-dry inverted. Glassware should be autoclaved. Plastic ware should be 
placed under UV light for ~15 minutes. Store glassware and plastic ware after being autoclaved 
or being cleaned by UV light.  


 







HPD Crime Laboratory  Standard Operating Procedures: Biology 
2 Facilities 


Unofficial Copy if Printed Page 2  of 2 Issued by Technical Leader 
 
Revision Date: July 31, 2012 
Effective Date: August 1, 2012 
 


2.3 Safety 


There are biological and chemical hazards in the laboratory. Each lab employee is responsible 
for familiarity with the Laboratory Safety Manual. Any incident or condition that occurs in or 
under the control of the laboratory and that threatens the immediate or future health of any 
individual must be immediately brought to the attention of the section supervisor and a 
laboratory safety officer. Corrective action related to safety incidents will be defined by 
laboratory management. 
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3          Equipment Quality Control and Maintenance 


3.1 Maintenance and Calibration 


In order to provide and maintain the quality of the work provided in the Biology section, it is 
necessary to ensure laboratory equipment is in good working order. Routine quality control and 
maintenance accomplishes this. The calibration intervals listed below are generally considered 
to be the minimum appropriate in each case, provided that the equipment is of good quality and 
of proven stability and the laboratory has both the equipment capability and expertise to perform 
adequate internal checks.  More frequent checks are acceptable.  If there is any question 
concerning the reliability of an instrument or piece of equipment, a maintenance check should 
be performed immediately. 


Full maintenance, calibration records, and repair activities shall be maintained and recorded in 
an equipment calibration and maintenance log. This log will include at a minimum: the date, 
activity, laboratory personnel performing or overseeing the activity, non-HPD technician(s) 
performing or overseeing the activity, and a record of quality control checks performed to verify 
operation prior to returning a piece of equipment to casework use. The section supervisor and 
QA Manager are responsible for ensuring all systems are checked and maintained as required.  


Critical equipment is any piece of equipment that must be maintained in a proper working order 
to ensure the reliability of results produced.  Some critical equipment and associated 
maintenance requirements can be found in the Quality Manual.  Additional equipment and 
maintenance requirements are included here. 


Equipment Operation Manuals 


Equipment operation manuals will be readily available to each examiner approved to use the 
equipment. 


3.2 Equipment 


Ultrasonic Cleaner 


Ultrasonic cleaners use ultrasonic energy in the form of sound waves to create a mechanical 
“scrubbing” action to loosen debris from all surfaces that the solution touches.  


This equipment’s condition is routinely maintained for the Biology section’s procedures. The 
water should be clear and clean with no evidence of bacterial/fungal growth or rust.  The 
following procedure should be performed as needed: Wash the inside of the ultrasonic cleaner 
with detergent and rinse well with water. Fill bath with the appropriate quantity of diH2O water.  


Mini-centrifuges 


Mini-centrifuges are bench top, unrefrigerated centrifuges that have been designed for quick 
spin-downs from tube walls and caps of tubes.  These mini-centrifuges are equipped with a 
circular, one sized rotor.  The maximum speed is 6000 rpm.  The relative centrifugal force can 
be determined as outlined in the manufacturer’s instructions, if required.  
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Please consult the appropriate equipment manual for specific instructions on maintenance and 
operation of the mini-centrifuge. These centrifuges will primarily be used for removing liquid 
from the cap of a microcentrifuge tube.  They will not be used for pelleting cellular material. 


Thermometers 


All thermometers must be either calibrated or their accuracy must be verified to ensure the 
temperature is being accurately measured.  


NIST-traceable thermometers must be purchased or re-certified at least once every two years.  
A NIST-traceable thermometer certified for two years and used for conducting performance 
checks on equipment shall require the annual performance check.  A NIST-traceable 
thermometer certified for two years that is not used for conducting performance checks does not 
require the annual performance checks and may be used until the certification expires.  A NIST-
traceable thermometer to be used beyond its certification date shall be recertified or be subject 
to the annual performance check requirements.   


The minimum requirements of a performance check of a thermometer used for performing 
performance checks may be accomplished: (1) through certification by an outside vendor; or (2) 
in-house by the comparison of one or more temperature readings at various time intervals 
against another NIST-traceable thermometer. 


Thermometers that are not NIST-traceable must be verified annually by comparison against a 
NIST-traceable thermometer.  Any deviation from the NIST-traceable thermometer will be noted 
and all other readings adjusted by the same amount, and in the same direction for each 
thermometer.  If the deviation is greater than 3°C, the thermometer should be serviced or 
replaced. 


Thermometers should be handled carefully to avoid breakage.  Thermometers may be wiped 
clean to facilitate easy and accurate readings.  If any discontinuities are detected, repair or 
replace the thermometer. 


Autoclaves 


Autoclaves are used to sterilize solutions, glassware, and instruments by subjecting them to 
high pressure and high heat simultaneously.  Autoclaves also may be used to sterilize 
biohazard trash prior to discarding.  Please consult the instructions on the outside of the unit for 
specific information on operation of the autoclave. 


Whenever an item is autoclaved, a small piece of autoclave tape must be adhered to the item, 
to verify correct functioning of the autoclave. Use proper sterilizer-loading procedures when 
placing materials in sterilizer chamber.  Those include: all solid containers/ instruments must be 
placed so that water or air will not be trapped in them and sufficient space must be left between 
items to allow steam circulation. The temperature gauge should read 1200C at the start and 
during the appropriate cycle.  


If the autoclave is not functioning properly, a qualified service technician may repair the 
instrument.   
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Alternate Light Source (ALS) Machines 


ALS machines are used to presumptively identify semen in forensic casework. The fan air filter, 
optical filters, and lenses should be cleaned on a regular basis (approximately every 6 months), 
where applicable. Please consult the appropriate equipment manuals for more specific 
instructions on maintenance and operation of the ALS machines. 


Swab Drying Box E025 


Swab drying boxes are used to dry swabs created in the lab during forensic casework.  Before 
and after each use, the box should be wiped inside and out with a 10% bleach solution or other 
lab-approved decontaminant and dried with a soft cloth.  Do not autoclave, immerse, or abrade 
the unit.   


Refrigerators and Freezers 


Please refer the Houston Police Department Crime Laboratory Quality Manual for refrigerator 
and freezer maintenance.  Reagents and evidence will be stored separately, either in separate 
cooling units or in separate space within those units. 


Pipettes 


Accuracy and precision in dispensing of volumes are important during many routine operations.  
The DNA section is supplied with pipettes that cover the volume range from 0.1 - 1000 µl.  
Calibration will be performed at least annually on these instruments.  When a pipette is 
determined to be performing improperly, it will be returned to the manufacturer, or another 
qualified repair technician, so that the problem may be identified and corrected. 


Quality control data should include the type of pipette, volume range, model, and serial number.   


The operating manual should be consulted for operation instructions prior to utilizing a pipette.   


In case of accidental entry of liquids into the pipette mechanism, remove the shaft from the 
assembly and clean with distilled water.  Dry with lint free tissue (i.e., Kimwipe). Inspect the seal 
assembly and piston for liquid.  Inspect the entire instrument for staining or corrosion.  If evident, 
do not use the pipette, and submit for service.  If no further problems are identified, reassemble.  


Water Filtration System 


Water is used in reagents that are prepared in the laboratory.  Therefore, it is necessary to 
ensure only high quality, reagent grade water is being utilized.  Generally, 15MΩ-cm or greater 
deionized water is sufficient for the reagents utilized in our laboratory. 


Water quality should be checked on a weekly basis.  The following procedure will be utilized: 
1. Turn on the deionized water. 


2. Allow water to run for 1-2 minutes. 
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3. Record both the MΩ-cm reading and the temperature reading displayed on the resistivity 
monitor in the Water Quality logbook. 


4. If reading is below 15MΩ-cm, call for service.  A qualified service technician may repair the 
system.  Label the system as being “out of service” until the appropriate service is performed 
and the instrument is functioning properly. 


Balances 


Please refer to the Houston Police Department Crime Laboratory Quality Manual for the balance 
calibration schedule.    
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4          Reagent Quality Control 
 
In order to provide and maintain the quality of the work provided in the Biology section, it is 
necessary to identify certain reagents as critical.  Critical reagents are those that require testing 
prior to use on evidentiary samples in order to prevent unnecessary loss of sample.   
 
If any critical reagent does not pass all quality control checks, it may not be utilized in casework. 
All inconsistencies will be documented and reported to the Section Supervisor. Problems that 
cannot be resolved must be reported to the manufacturer. 
 
Reagents and supplies that have passed their expiration dates may not be used on casework 
samples.  Outdated reagents may be used for training purposes only, but must be clearly 
marked as such. 


4.1 Chemical and Reagent Labels 


Purchased chemicals and reagents will be marked on the container with the date received 
and/or date opened.  In general, the manufacturer’s labeling will be followed to determine 
expiration dates of purchased chemicals and reagents.  If no manufacturer expiration exists for 
a purchased reagent, it will be considered expired 5 years from the date received and should be 
marked on the container. 


Prepared reagent labels will include the reagent name, initials of preparer and expiration date.  
In general, most solutions prepared in the Biology section shall expire 1 year from the date of 
preparation.  However, the expiration date of the overall reagent will be no later than the 
expiration date of the individual reagent with the nearest expiration date (unless otherwise 
specified).  Additional information may be documented in a reagent log.  The lot number 
contains the date prepared and the initials of the preparer, e.g. mmddyyinitials. 


4.2 Quality Control Checks 


The following shall be tested to confirm that they are working properly with a positive and 
negative control each day used: 


• Acid Phosphatase Spot Test  


• Alternate Light Source  


• Luminol mixture 


• Phenolphthalein test kit 


The following shall be quality control checked to confirm they are working properly with each 
new lot received: 


• ABAcard® HemaTrace® kits  


• Phosphate Buffered Saline (1X) 


• SERI Christmas Tree Stain  


• SERATEC® PSA Semiquant test devices  
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4.2.1 Acid Phosphatase (AP) Spot Test 


Scope  


AP Spot Test solution undergoes a color change (Brentamine reaction) in the presence of acid 
phosphatase, which is found in highest concentration in semen.  Instructions for use and 
interpretation are in the AP Spot Test procedure.   


Safety 


This reagent presents the following hazards: may cause cancer; irritant to eyes, respiratory 
system and skin; and corrosive (can cause burns).  Wear gloves, lab coat, and mask during 
preparation and use. Broken skin should be covered. 


Equipment and Supplies 
• AP Spot Test premixed powder – purchased 
• Darkened or foil wrapped container for storage 
• Scale 
• Sterile diH2O  
• Timer 
• Known semen sample  
• Known non-semen sample 


Preparation 
1. Measure 10mL of sterile diH2O in an appropriate container. 


2. Add 0.26g of the purchased AP Spot Test premixed powder. 


3. Mix until AP Spot Test premixed powder is completely dissolved in water.  


Note: Volume may be smaller or larger than 10mL, but the amount of AP Spot Test 
premixed powder added should be adjusted accordingly. 


Prior to use each day, the prepared AP solution must be subjected to the appropriate in-house 
quality control test as outlined below: 


1. A known semen sample will be used as a positive control.  This in-house-prepared 
sample is typically presented on filter paper. 


2. An untreated piece of filter paper or swab moistened with sterile diH2O will be used as a 
negative control.  Ideally, the negative control substrate mimics your sample substrate 
as closely as possible.   


3. Apply ~ 1 drop of prepared AP solution to both controls. 


4. Observe samples for 60 seconds for a color change. 


5. The known semen sample must give a strong purple color change indicating a positive 
result. 
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6. The untreated filter paper or sterile swab must have no color change indicating a 
negative result. 


The results of each control test must be recorded on every applicable serology worksheet. 


Storage, Labeling, and Expiration 
Store prepared solution in a darkened or foil wrapped container. Label with reagent name, lot 
number, and expiration date. Reconstituted reagent is stable and sensitive for one day’s use – 
make solution fresh daily.  Store purchased powder frozen. Purchased powder may be used on 
casework samples up to the expiration date stated on the bottle. 
 
4.2.2 Alternate Light Source  


Scope  


An Alternate Light Source is specially designed for detection of forensic stains, fibers, and 
fingerprints. Instructions for use and interpretation are in the Alternate Light Source procedure. 


Safety 


This instrument presents the following hazards: exposing the skin to the beam of light (directly 
from the unit) can cause burns and other skin damage.  It is essential that proper eye protection 
be provided.  Avoid looking directly at the light source, reflected, or refracted light.  Remove all 
unnecessary reflective surfaces from exam room. Wear goggles, gloves, lab coat, and other 
proper laboratory attire. 


Mini-Crimescope MCS-400 ALS: If the bulb fails (suddenly stops emitting light), it may leak 
vapors for a few minutes.  To be safe, immediately leave the room and let the unit run (fans) for 
5-10 minutes until vapors are vented. 


Equipment and Supplies 
• ALS set at 400 or 455 nm 
• Orange and/or yellow glasses 
• Known semen sample 
• Known non-semen sample 


Prior to use each day, the ALS must be subjected to the appropriate in-house quality control test 
as outlined below: 


1. Turn on power switch and ensure the fans are working. 


2. Wear the proper glasses.  


3. Turn on lamp switch. 


4. Darken the examination room. 


5. Direct the ALS at the samples. 


6. The known semen sample must fluoresce indicating a positive result.  


7. The known non-semen sample must not fluoresce indicating a negative result. 
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When ready to shut down the ALS, turn off lamp switch and wait for the unit to cool down (~5 
minutes).  Then turn off the power switch. 


The results of each control test must be recorded on every applicable serology worksheet. 


Storage and Expiration  


Store equipment in a clean, dry atmosphere.   The bulb should be replaced after 3-3.5 years of 
non-regular usage. 
 
4.2.3 Luminol 


Scope  


Catalytic tests for blood are based on the peroxidase-like activity exhibited by the heme group of 
hemoglobin.  In the case of luminol, the catalytic oxidation of the substrate compound produces 
light. Instruction for use and interpretation are in the Luminol procedure. 


Safety 


This reagent presents the following hazards: luminol is an irritant.  Sodium perborate and 
sodium carbonate are toxic and irritating. Avoid breathing dust; do not get in eyes, on skin, or on 
clothing.  Avoid breathing sprayed solution. Wash hands after handling. Gloves must be worn 
during testing.  Broken skin should be covered.  


Equipment and Supplies 
• Luminol powder:  3-aminophthalhydrazide  
• Sodium carbonate  
• Sodium perborate  
• Sterile diH2O            
• Two darkened or foil wrapped spray bottles 
• Scale 
• Known blood sample 
• Known non-blood sample 


Preparation (Reagent A) 
1. Measure 250 mL of diH2O. 


2. Add 2.5 g of sodium carbonate. 


3. Mix until all of the powder is dissolved. 


4. Add 0.5 g of luminol powder. 


5. Mix until all of the powder is dissolved. 
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Preparation (Reagent B) 
1. Measure 250 mL of diH2O.  


2. Add 6.5 g of sodium perborate. 
3. Mix until all of the powder is dissolved. 


Mix equal volumes of Reagents A and B to create a luminol mixture.  The mixture is unstable 
and must be prepared fresh immediately before use; it is only stable for about one hour.  


Prior to use, the luminol mixture must be subjected to the appropriate in-house quality control 
test as outlined below: 


1. Darken the examination room as completely as possible. 


2. Spray luminol mixture onto a known blood sample (prepared in-house). 


3. Spray luminol mixture onto a known non-blood sample (cotton swab or filter paper). 


4. Observe samples for immediate luminescence. 


5. The known blood sample must give an immediate luminescence indicating a positive 
result. 


6. The cotton swab or filter paper must not produce luminescence indicating a negative 
result. 


The results of each control test must be recorded on every applicable serology worksheet. 


Storage, Labeling, and Expiration 


The luminol powder, sodium carbonate and sodium perborate should be stored in a cool, dry, 
well-ventilated area away from incompatible substances. The expirations for reagents A and B 
(stored separately) are 8 weeks from date solutions were prepared.  If stored, the labels must 
include, at a minimum, "Luminol, Reagent A" or "Luminol, Reagent B" as appropriate, initials, 
the date prepared, and the expiration date.  Prior to each use, check the reagents for 
precipitate.  If a precipitate has formed in either reagent, ensure that the precipitate is back in 
solution before use. Luminol mixture should be labeled with the appropriate lot number and 
expiration date. The mixture will expire one hour after use. 
 
4.2.4 Phenolphthalein Test Kit 


Scope  


PHT Test Kit Solutions B and C are used for presumptive blood identification by oxidizing 
phenolphthalin (colorless in a basic solution such as the test reagent) to phenolphthalein (pink) 
in the presence of heme and hydrogen peroxide. Instructions for use and interpretation are in 
the phenolphthalein test kit procedure. 


Safety 


This reagent presents the following hazards:  
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Solution B: Flammable.  Handle with care.  Harmful or fatal if swallowed, inhaled, or absorbed 
through skin.  Avoid contact with eyes, skin, and clothing.  Light sensitive!  Avoid light, heat, 
sparks, and flame. Keep container tightly closed. 


Solution C: Handle with care. May be harmful if swallowed, inhaled, or absorbed through skin.  
Avoid contact with eyes, skin, and clothing.  Avoid heat, sparks, and flame.  Keep container 
tightly closed. 


Wear gloves, lab coat, and mask during preparation and use. Broken skin should be covered. 


Equipment and Supplies 
• Solution B  
• Solution C 
• Sterile diH2O  
• Sterile cotton swab(s) 
• Known blood sample 
• Known non-blood sample 


Prior to use each day, PHT Solutions B and C must be subjected to the appropriate in-house 
quality control test as outlined below: 


1. Rub a cotton swab moistened with sterile diH2O on a known bloodstain sample. This 
swab will be used as a positive control. 


2. An untreated cotton swab moistened with sterile diH2O will be used as a negative 
control. 


3. Apply ~1 drop of Solution B to each swab. 


4. Apply ~1 drop of Solution C to each swab. 


5. Observe the swabs for a color change. 


6. The cotton swab with the known bloodstain sample must give an immediate pink color 
change indicating a positive result. 


7. The untreated cotton swab must have no color change indicating a negative result. 


The results of each control test must be recorded on every applicable serology worksheet. 


Storage, Labeling, and Expiration 


PHT test kits can be stored at room temperature.  Each analyst will have an aliquot of Solutions 
B and C that will be placed in amber bottles stored at room temperature or refrigerated. Each 
bottle will be labeled with appropriate reagent name, lot numbers, and expiration dates. The kits 
may be used on casework samples up to the expiration date stated on the bottles.  
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4.2.5 ABAcard® HemaTrace® Test Devices 


Scope  


ABAcard® HemaTrace® test kits are used to determine the presence of human blood in 
suspected blood stains. Instructions for use and interpretation are in the ABAcard® 
HemaTrace® procedure. 


Safety 


Wear gloves, lab coat, mask, and other proper laboratory attire. Broken skin should be covered.  


Equipment and Supplies 
• ABAcard® HemaTrace® test device(s) 
• ABAcard® HemaTrace® extraction buffer  
• Pipette and pipette tips 
• Known blood sample 
• Timer 


Each new lot of ABAcard® HemaTrace® test kits must be subjected to the appropriate in-house 
quality control test as outlined below: 


1. Make a 1:106 dilution from a known human blood sample in extraction buffer provided in 
kit. 


2. Add 150μl of dilution to sample well “S” of one test device to be used as a positive 
control. 


3. Add 150 µl of extraction buffer from kit to sample well of second test device to be used 
as a negative control.  


4. Read results up to 10 minutes from application of sample. 


5. The 1:106 dilution of known human blood must give a positive result.  The extraction 
buffer provided in the kit must give a negative result. 


Storage, Labeling, and Expiration 


The test devices must be stored at room temperature (below 82ºF) and must remain in the 
sealed pouch until use. Label each test device with the name of the appropriate sample used. 
The test kits may be used on casework samples up to the expiration date stated on the box.  
 
4.2.6 Phosphate Buffered Saline (1X) 


Scope  


PBS is used as an extraction agent for serological stains. Instructions for use and interpretation 
are in the Phosphate Buffered Saline procedure.  
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Safety 


This reagent presents the following hazards: causes severe eye, respiratory tract and skin 
irritation.  Avoid contact with skin and clothing.  Wear gloves, lab coat, and other proper 
laboratory attire.  Broken skin should be covered. 


Equipment and Supplies 
• OmniPur 10X PBS Premixed Powder 
• diH2O 
• Graduated cylinder 
• Two sterile containers for storage 


Preparation (10X) 
1. Measure 1 liter of diH2O. 


2. Add 100g of 10X PBS Premixed Powder. 


3. Mix until all of the powder is dissolved. 


4. Autoclave solution. 


Preparation (1X) 
1. Measure 100mL of 10X PBS solution. 


2. Measure 900 mL of sterile diH2O. 


3. Mix 10X PBS and sterile diH2O. 


Each new lot of 1X PBS must be subjected to an appropriate in-house quality control test with 
the lot of SERATEC® PSA Semiquant test currently in use. See SERATEC® PSA Semiquant 
test quality control procedure for further detail. 


Storage, Labeling, and Expiration 


1X and 10X PBS solutions can be stored at room temperature.  Label each bottle with 
appropriate concentration, lot number and expiration date. Expiration for both PBS 
concentrations is one year from the date 10X PBS solution was prepared.  Both concentrations 
of PBS may be used on casework samples up to this expiration date.  
 
4.2.7 SERI Christmas Tree Stain 


Scope  


SERI Christmas Tree Stain is a Kernechtrot-Picroindigocarmine differential biological stain that 
assists in scanning slides for the presence of spermatozoa.  The test consists of a two stain 
method which dyes sperm heads red, tails green and epithelium green or blue with red nuclei. 
Instructions for use and interpretation are in the SERI Christmas Tree Stain procedure. 
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Safety 


This reagent presents the following hazards: May cause irritation upon contact.  Toxic.  Do not 
swallow. Do not inhale. Avoid contact with skin and eyes. Wear gloves and proper laboratory 
attire. Broken skin should be covered. 


Equipment and Supplies 
• Microscope slide  
• Known semen sample 
• Pipette and pipette tips 
• Heat block 
• Christmas Tree Stain - Solution A and Solution B  
• Timer 
• Tap water 
• 95%  ethanol 
• Compound microscope 


Each new lot of SERI Christmas Tree Stain must be subjected to the appropriate in-house 
quality control test as outlined below: 


1. Pipette 10 µl of a neat in-house sample onto a glass slide.  Fix smear by heating the 
slide on the heat block until dry. 


2. Stain the slide. 


a. Cover the sample area on the slide with Solution A for 10 minutes. 


b. Wash with tap water by gentle flooding. 


c. Cover the sample area with Solution B for 15 seconds. 


d. Wash with tap water by gentle flooding. 


e. Flood the slide with 95% ethanol and allow the slide to dry for at least 5 minutes 
on the heat block. 


3. Examine the slide for the presence of spermatozoa at 1000X magnification. Sperm 
heads must be stained red, and any observed tails must be stained green indicating a 
positive result. 


Storage and Expiration 


The stain must be stored at room temperature.  The stain may be used on casework samples 
up to the expiration date stated on the bottles.  
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4.2.8 SERATEC® PSA Semiquant Test Devices 


Scope  


SERATEC® PSA Semiquant test devices are used to indicate the possible presence of p30 in 
suspected semen stains.  Instructions for use and interpretation are in SERATEC® PSA 
Semiquant test procedure.   


Safety 


Wear gloves, lab coat, mask, and other proper laboratory attire. Broken skin should be covered. 


Equipment and Supplies 
• SERATEC® PSA Semiquant test device(s) 
• 1X PBS 
• Pipette and pipette tips 
• Known semen sample 
• Timer 


Each new lot of SERATEC® PSA Semiquant Test devices must be subjected to the appropriate 
in-house quality control test as outlined below: 


1. Make a 1:105 dilution from a known semen sample in 1X PBS. 


2. Add 120 μl of dilution to sample well of one test device to be used as a positive control. 


3. Add 120 µl of 1X PBS to sample well of second test device to be used as a negative 
control.  


4. Read results up to 10 minutes from application of sample. 


5. The 1:105 dilution of known semen must give a positive result.  The 1X PBS must give a 
negative result. 


6. Mark the stock solution bottle of 1X PBS with all lot numbers of SERATEC® PSA 
Semiquant test devices quality control checked with that lot of 1X PBS. 


Storage, Labeling, and Expiration 


The test devices must be stored at room temperature and must remain in the sealed pouch until 
use. Label each test device with the name of the appropriate sample used. The test devices 
may be used on casework samples up to the expiration date stated on the sealed pouch.  


4.3 Logbook 


Reagent preparation logs should include the lot number, the reagent name, the initials of 
preparer, and the expiration date. Quality control logs for ABAcard® HemaTrace® kits, 
Phosphate Buffered Saline (1X), SERI Christmas Tree Stain, and SERATEC® PSA Semiquant 
tests will also contain the test date, signature of the analyst performing the quality control, a 
second reader signature, if applicable, and date and any supporting documentation necessary 
to demonstrate the reagent met all of the standards.   
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5 Evidence Evaluation and Handling 


The Biology section provides body fluid identification (semen and blood) and performs the 
collection and preservation of trace evidence and possible contact DNA evidence. 


5.1 Case Acceptance and Evaluation 


Refer to the Quality Manual for procedures regarding the submission of evidence into the HPD 
Crime Laboratory.  Before a case is worked, the case and the requested examinations will be 
evaluated.  The examiner should be aware of the requested examinations, and when possible, 
the reason(s) for the requested analyses and the quality and quantity of the evidence.   


In order to expedite casework, with the exception of sexual assault kits, it is recommended that 
5-10 items of evidence should initially be screened for cases containing large volumes of 
evidence.  Emphasis should be placed on those items believed to be of the most significant 
evidentiary value after consultation with the submitting party.  Of the items screened, it is 
recommended that a maximum of 5 items of evidence continue on to DNA analysis initially.  
Additional items may be analyzed at a later time.  Individual case needs may dictate that the 
initial quantity of examined items is greater than the recommended range presented above.    


When submitted in conjunction with a sexual assault kit, clothing evidence does not typically 
have to be examined if the kit components yield sufficiently positive samples.  (“Sufficiently 
positive” is fluid and relevant to the case information.)  Clothing should be examined if the 
corresponding sexual assault evidence kit does not reveal any positive probative evidence, if 
there are multiple suspects, or there is a recent consensual sexual partner.  Good judgment 
using the case information and/or the client’s specific requests should always supersede this 
guideline.       


5.2 Evidence Handling 


It is not possible to anticipate every situation that may arise or to prescribe a specific course of 
action for every case; therefore, the examiner must exercise good judgment based on 
experience and common sense.  In some cases, the manual offers guidelines for analysis that 
must be tempered with the experience of the examiner.  However, any portion of a procedure 
not explicitly qualified as a guideline may not be modified for use in casework without prior 
written approval as outlined in the Quality Manual. 


Universal Precautions 


Body fluids and extracts may contain infective agents. All analysts should routinely use 
appropriate barrier precautions to prevent skin and mucous membrane exposure when in 
contact with any body fluids. Gloves should be worn and changed after contact with each piece 
of evidence. Masks, lab coats, and protective eyewear should be worn during procedures that 
anticipate contact with body fluids to prevent exposure of mucous membranes of the mouth, 
nose, and eyes. All analysts should take precautions to prevent injuries caused by scalpels or 
other sharp instruments or devices during procedures, when cleaning, or during disposal. After 
sharp instruments are used, they should be placed in a puncture-resistant container for 
disposal.  
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Evidence Requiring Latent Print Examination 


Submitting parties may request that items be analyzed for latent prints as well as biological 
material. In general biological evidence examinations precede any latent print examination. 
Appropriate steps should be taken, including consultation with the submitting party and/or a 
latent prints examiner, to ensure the appropriate course of action for the evidence presented.  In 
some cases, it may be best if one type of examination is chosen over another. If an analyst finds 
a distinct print during examination, appropriate steps should be taken to preserve the print and 
inform the officer. 


Storage of Evidence 


Biological evidence must be properly stored to preserve biochemicals assayed in body fluid 
identifications and DNA typing for current and future analyses. Storage conditions for all types of 
evidence present must be considered so that the evidence is not compromised.  In addition to 
the storage requirements detailed in the Quality Manual, the following procedures will be 
followed: 


Sexual assault kits may be stored in a cooler, freezer, or dry area at room temperature once 
received in the laboratory. After analyses, sexual assault kits may be stored at room 
temperature.  Sexual assault kits that contain blood or urine specimens are ideally stored in a 
refrigerator.   


When applicable, wet evidence should be dried upon receipt.  Refrigerate or freeze liquid whole 
blood specimens until a sample is dried on an appropriate substrate; be careful when frozen 
blood has thawed, as it may expand and cause vial breakage. Portions of blood standards 
submitted in liquid form should be dried on stain cards within 30 days of receipt by the assigned 
analyst. Once the sample is in dried form, the liquid blood tube will be placed back in its original 
packaging and returned to the property room.   


Cases containing small, dry items may be stored at room temperature or frozen depending on 
available space.  Larger items such as clothing, bedding, weapons, and other physical evidence 
containing bloodstains should be stored in a dry area at room temperature until examination.   


Consumption of Evidence 


The evidence’s quality and quantity will be preserved as much as possible without sacrificing 
the quality of the analyses.  Good judgment must be exercised to determine the smallest 
amount of sample that should be consumed for analysis that will still provide accurate results.  
Whenever possible, at least half of the evidence sample will be preserved for possible re-
analysis (for both additional screening and additional DNA analysis).  When this is not possible, 
the appropriate personnel (submitting officer, prosecuting attorney, and/or defense attorney) will 
be consulted and written permission will be obtained before the evidence is consumed.  All 
evidentiary hairs are treated individually and cannot proceed to DNA analysis without 
consumption permission. 


Chain of Custody 


Refer to the Laboratory Quality Manual for chain of custody policies and procedures. 
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Reference Samples 


Whenever possible, reference samples should be collected and retained from suspects, 
complainants, witnesses, consensual sex partners, and/or other individuals for the purposes of 
elimination.  Oral swabs are the preferred reference sample for the HPD Crime Laboratory, but 
blood is certainly a viable source of reference material.  Anecdotally, Sexual Assault Nurse 
Examiner (SANE) protocol dictates that evidentiary oral swabs are not only collected well before 
reference/known saliva swabs, but also after oral rinsing to help prevent possible foreign DNA 
from contaminating a reference/known saliva sample.    


Potential for Contact DNA 


Should contact DNA potentially be probative in a case, it is permissible for the examiner to 
bypass certain procedures that could possibly remove contact DNA that may be present.  For 
example, an examiner may choose to skip the presumptive Acid Phosphatase press-out test 
and simply portion for the confirmatory microscopy examination in an effort to preserve potential 
contact DNA, if both penile and digital penetrations are alleged.  Examiners may also choose to 
skip serological analysis entirely in an effort to maximize the available DNA.  Case records must 
clearly document when and why a routine procedure such as the acid phosphatase or 
phenolphthalein press-out test is not performed. 
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6  Blood Detection 
Please refer to SOP #4 (Reagent Quality Control) for quality control testing, storage, 
labeling, and expiration guidelines, of the Phenolphthalein Test Kit, Luminol and 
ABAcard® HemaTrace® Test Devices. 
 
Many samples submitted to the Houston Police Department Crime Laboratory are tested for the 
presence of blood.  Generally, a sample will be subjected to a presumptive phenolphthalein test.  
If positive, the sample will be subjected to a confirmatory test for the presence of human blood.  
Testing is typically discontinued on phenolphthalein negative samples. 


6.1 Phenolphthalein Test Kit 
Scope 
Catalytic tests for blood are based on the peroxidase-like activity exhibited by the heme group of 
hemoglobin.  The test is exceedingly sensitive to minute traces of hemoglobin and its 
derivatives but will produce a false positive reaction in the presence of any of a number of 
oxidizing substances.  Should a color reaction take place, the result only indicates the possible 
presence of blood; the test is therefore a presumptive test.   


Safety 


This reagent presents the following hazards:  


Solution B: Flammable.  Handle with care.  Harmful or fatal if swallowed, inhaled, or absorbed 
through skin.  Avoid contact with eyes, skin, and clothing.  Light sensitive!  Avoid light, heat, 
sparks, and flame. Keep container tightly closed. 


Solution C: Handle with care. May be harmful if swallowed, inhaled, or absorbed through skin.  
Avoid contact with eyes, skin, and clothing.  Avoid heat, sparks, and flame.  Keep container 
tightly closed. 


Wear gloves, lab coat, and mask during preparation and use. Broken skin should be covered. 


Equipment, Materials, and Reagents 
• Sterile diH2O 
• Sterile cotton swab(s) or filter paper  
• Phenolphthalein Forensic Test reagents* - Solutions B and C 


* Solution A is also included in the Phenolphthalein Forensic Test. However previous testing 
showed that using sterile diH2O in place of Solution A did not affect the outcome of this test.  
Therefore, sterile diH2O will be used in place of Solution A. 


Procedure 
1. Moisten a sterile cotton swab or piece of filter paper with sterile diH2O.   


2. Rub or press down on the suspected bloodstain with a sterile cotton swab or filter paper 
to allow for any possible blood to transfer. 
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3. Apply approximately 1 drop of Solution B to the swab or filter paper. 


4. Observe briefly to identify color change. A green color is often observed when blood is 
present; any other color change should be documented. 


5. Add approximately 1 drop of Solution C to the swab or filter paper. 


6. Observe the swab or filter paper for an immediate pink color change indicating a positive 
reaction. 


7. After interpretation, mark the items/areas tested with the results. 


8. Discard the swab or filter paper by placing it in the biohazard trash. 


Interpretation 
Appearance of an immediate pink color change after the application of Solution C is a 
presumptive positive result for blood.  No color change indicates a presumptive negative result 
for blood.  A negative result indicates that blood is absent or below the detection threshold. 


Substrate controls may be included in body fluid identification tests as appropriate. 


6.2 Luminol 


Scope 


Catalytic tests for blood are based on the peroxidase-like activity exhibited by the heme group of 
hemoglobin.  In the case of luminol, the catalytic oxidation of the substrate compound produces 
light.  Because the reagents are applied as a spray over a large area, the test is primarily used 
in the visualization of bloodstain patterns.  As with similar presumptive blood tests, a number of 
oxidizing substances will produce a false positive reaction.  Should a positive reaction take 
place, the result only suggests the presence of blood; the test is therefore a presumptive test.   


Safety 


This reagent presents the following hazards: luminol is an irritant.  Sodium perborate and 
sodium carbonate are toxic and irritating. Avoid breathing dust; do not get in eyes, on skin, or on 
clothing.  Avoid breathing sprayed solution. Wash hands after handling. Gloves must be worn 
during testing.  Broken skin should be covered.  


Equipment and Supplies 
• Luminol powder:  3-aminophthalhydrazide  
• Sodium carbonate  
• Sodium perborate  
• Sterile diH2O            
• Two darkened or foil wrapped spray bottles 
• Scale 


Preparation (Reagent A) 
1. Measure 250 mL of sterile diH2O. 


2. Add 2.5 g of sodium carbonate. 
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3. Mix until all of the powder is dissolved. 


4. Add 0.5 g of luminol powder. 


5. Mix until all of the powder is dissolved. 


Preparation (Reagent B) 
1. Measure 250 mL of sterile diH2O.  


2. Add 6.5 g of sodium perborate. 
3. Mix until all of the powder is dissolved. 


Procedure 
1. Mix equal volumes of Reagents A and B to create a luminol mixture.  The mixture is 


unstable and must be prepared fresh immediately before use; it is only stable for about 
one hour.  


2. Darken the examination room as completely as possible. 


3. Spray luminol mixture onto evidence and observe for luminescence (spraying will 
deposit a light white film on surfaces). 


4. Document or photograph luminescent areas. 


5. Re-spray as necessary. The ability to further test the stain decreases with increased or 
repeated spraying.  Excessive spraying will cause stains to run, therefore, excessive 
spraying of non-porous surfaces is not suggested. 


6. Dispose of excess solution in the regular sink, flushing with water.  


Interpretation 


Faint to strong luminescence shows oxidation of the luminol reagent and represents a positive 
presumptive result for blood. A negative result (a lack of luminescence) indicates that blood is 
absent or below the detection threshold. 


Substrate controls may be included in body fluid identification tests as appropriate. 


6.3 ABAcard® HemaTrace® Test Devices 


Scope 


The ABAcard® HemaTrace® test is a qualitative detection method specifically designed for 
forensic identification of human blood. Heme is a part of the hemoglobin molecule that is 
characteristic of red blood cells found in blood.   The ABAcard® HemaTrace® has been shown 
to detect as little as 0.05 µg/ml of hemoglobin in 10 minutes. 


The sample is added to a sample well where any detectable human hemoglobin (hHb) present 
in the sample will bind with mobile monoclonal antihuman Hb antibody which has an attached 
pink dye particle. The resultant mobile antigen-antibody complex migrates through an absorbent 
strip to an area where an immobile polyclonal antihuman Hb antibody is bound. The mobile 
antigen-antibody complex binds to the immobile antibody creating an antibody-antigen-antibody 
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sandwich. Conjugated pink dye particles become visible in the area of immobilized antibody (in 
the test area: “T”) when the hHb concentration in the sample exceeds 0.05 µg/ml. The resultant 
pink band indicates a positive result.  As an internal positive control, hHb antibody-dye 
conjugates cannot bind to the antibody in the test area “T”, but are captured by an immobilized 
anti immunoglobulin antibody present in the control area “C” forming a complex.  The captured 
pink dye particles will thus form a band in the control area “C”, indicating that the test has 
worked properly and that appropriate procedures have been followed.   


Hemoglobin from the Family Mustelidae (ferrets) and higher primates also gives a positive 
result.  The examiner must evaluate the likelihood of blood from either of these sources being 
present when this test is used as, forensically, the practical implications of this cross reactivity is 
minimal.   


The ABAcard® HemaTrace® test may be skipped if, in the analyst’s opinion, consumption for 
human origin testing will reduce the potential success of subsequent DNA analysis.  Samples 
that are of limited size may be documented as Quantity Not Sufficient For Further Analysis 
(“QNS”).  Only a presumptive screening result will be reported but DNA analysis may be 
performed. 


Equipment, Materials, and Reagents 


• ABAcard® HemaTrace® Test device – one per sample  
• ABAcard® HemaTrace® extraction buffer  
• Pipettes and pipette tips 
• Timer 


Procedure 
1. Allow the sample(s) to warm to room temperature if they have been refrigerated. 
2. Extract body fluid by placing suspected bloodstain sample into the extraction buffer 


provided with the kit and allow to sit for 5-30 minutes.  Aged samples may be less 
soluble, and should therefore be soaked closer to 30 minutes. The extract(s) may be 
placed at room temperature in an ultrasonic cleaner for 5-15 minutes.  The analyst must 
exercise good judgment regarding the amount of sample to be portioned for each 
ABAcard® HemaTrace® test device, providing sufficient sample for subsequent DNA 
analysis.  Stain intensity and size are a few characteristics that should be considered. 
Generally, up to approximately ¼ of a swab or up to approximately (1 cm)2 of a stain 
may be consumed for this analysis.   


3. For each sample, unwrap and label an ABAcard® HemaTrace® test device. 
4. Add 150 µl of supernatant to the sample well “S” of the device. 
5. Results may be read up to 10 minutes from application of the supernatant.  Positive 


results can be seen as early as 2 minutes.   
6. Record the ABAcard® HemaTrace® test results on the Serology Results worksheet. 
7. Have a second qualified analyst examine the ABAcard® HemaTrace® test device and 


verify the documented test result(s) by initialing and dating the appropriate Serology 
Results worksheet.    
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Interpretation 


There are two lines that appear on the test device: 
1. Control “C” line: the presence of this line confirms the integrity of the test components 


and the test procedure. It is expected for all tests and must be present. Absence of the 
“C” line is an invalid result and the test should be repeated if adequate sample remains. 


2. Test “T” line: A line indicates the presence of human hemoglobin and should be 
documented as a positive result. The absence of a line or a line that appears after 10 
minutes is a negative result. A negative result indicates that blood is absent or below the 
detection threshold. 


Substrate controls may be included in body fluid identification tests as appropriate. 
 
Note: the presence of the “High Dose Hook Effect” may give false negative results due to the 
presence of a high concentration of human hemoglobin in the sample.  When huge amounts of 
human Hb bind to the antibody to form an antigen-antibody complex but also free Hb migrates 
towards the test area “T”, the antibody in the test area “T” is blocked by this free Hb.  As a 
result, the mobile antigen-antibody complex with the pink color cannot bind to the antibody and 
the pink line cannot form in the test area “T”, even though a lot of Hb is actually present.  In 
such cases where human blood is strongly suspected, the extract may be retested using a 1:10 
or 1:100 fold dilution. 


 
6.4 References 


1. Abacus Diagnostics, Inc. ABAcard® HemaTrace® For the Forensic Identification 
of Human Blood Technical Information Sheet. 
 


2. Gaensslen, Robert E. 1983. Sourcebook in Forensic Serology, Immunology, and 
Biochemistry.  U.S. Department of Justice, National Institute of Justice. Sections 
10.3.2 and 10.3.3. 
 


3. Lee, Henry C. 1982. Identification and grouping of bloodstains. In: Forensic 
Science Handbook, Volume 1. Richard Saferstein, ed. Prentice-Hall, Inc., 
Englewood Cliffs, New Jersey. Chapter 7, p. 273. 
 


4. Lytle, L. T. 1978. Chemiluminescence in the visualization of forensic bloodstains. 
Journal of Forensic Sciences 23(3): 550-562. 
 


5. Saferstein, R. Forensic Science Handbook: Identification and Grouping of 
Bloodstains, (Prentice-Hall, Inc., 1982), p. 274. 
 


6. Stoilovic, M.  1991.  Detection of semen and blood stains using Polilight as a light 
source.  Forensic Science International 51: 289-296. 
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7 Semen Detection 
Please refer to SOP #4 (Reagent Quality Control) for quality control testing, storage, 
labeling, and expiration guidelines, of the Acid Phosphatase Spot Test, Alternate Light 
Source, SERI Christmas Tree Stain, Phosphate Buffered Saline (1X), and SERATEC® PSA 
Semiquant test devices. 
 
Many samples submitted to the Houston Police Department Crime Laboratory are tested for the 
presence of semen.  Generally, a sample will be subjected to a presumptive acid phosphatase 
test, followed by a confirmatory microscopic examination for the presence of spermatozoa.  If 
the sample is not microscopically positive, a third test, the test for the presence of prostate-
specific antigen, may be warranted and executed. 


 
7.1 Alternate Light Source 


Scope 


The Alternate Light Source (ALS) lamps within this lab will be used for detection of forensic 
semen stains.  These lamps provide intense light of specific wavelengths through a hand-held 
wand. 


Some dried semen stains on cloth are detectable visually because their color, off-white or 
yellow, is different from that of the material on which the semen has been deposited.  However, 
on some substrates, semen stains are not readily visible.  Under intense blue light (~450 nm), 
semen stains typically fluoresce. Blood absorbs light and will not fluoresce; fibers and other 
bodily fluids can typically fluoresce. Should fluorescence take place, the result only suggests the 
presence of semen; the test is therefore a presumptive test.  


Equipment, Materials, and Reagents 
• Alternate light source (ALS) set at 450-455 nm. 
• Orange and/or yellow glasses 


Procedure 
1. Turn on power switch and ensure the fans are working. 


2. Wear the proper glasses given and darken the examination room. 


3. Turn on lamp switch. 


4. Direct the ALS at the evidence samples. 


5. Document areas of apparent fluorescence on the evidence. 


When ready to shut down the machine, turn off lamp switch and wait for the unit to cool down 
(~5 minutes).  Then turn off the power switch. 


Interpretation 
Should a stain fluoresce, the result only indicates the possible presence of semen.   
 
Substrate controls may be included in body fluid identification tests as appropriate. 
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7.2 Acid Phosphatase Spot Test 


Scope  
Acid phosphatase (AP) is found in relatively large quantities in semen and its presence is 
indicative of the possible presence of semen in a stain. In the following procedure, acid 
phosphatase is detected by a color-change reaction.  Acid phosphatase liberates the phosphate 
from α-naphthyl phosphate, and the released naphthol combines with tetrazotized o-dianisidine 
to form a purple azo dye. 
 
The AP test is semi-quantitative.  A stronger reaction is more likely to indicate semen.  
However, because acid phosphatase occurs in other body fluids, most notably vaginal 
secretions, this is only a presumptive test.  The presence of semen in the sample can 
subsequently be confirmed by the presence of spermatozoa. 


Equipment, Materials, and Reagents 
• Sterile diH2O  
• Sterile cotton swab(s) or filter paper 
• AP Spot Test reagent  
• Timer 
• Non-porous surface  
• Clips (optional) 


AP Procedure for Swabs 


Note: Begin at step 1 when it is necessary to transfer the suspected semen sample from an item 
of evidence to a cotton swab or swabs for ease of testing.  Otherwise, begin at step 3 following 
the procedure below: 


1. Moisten cotton swab(s) with sterile diH2O. 


2. Swab the suspected semen stain from the evidence. 


3. Moisten filter paper with sterile diH2O. 


4. Press the swabs firmly onto the filter paper. 


5. Apply one or two drops of the AP Spot Test reagent to the filter paper. 


6. Observe the treated filter paper for up to 60 seconds for a color change. 


7. After interpretation, document the test results onto the serology worksheet(s). 


8. Discard used filter paper by placing it in the biohazard trash. 


AP Mapping Procedure  


This procedure can be used when larger items of evidence are presented.   
1. Spread the clothing item, bedding, towel, or other item flat onto a non-porous surface 


(use clips if necessary).  
2. Moisten filter paper with sterile diH2O.   
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3. Lay the moist filter paper over the item or area of the item to be tested. Press the paper 
firmly against the item for approximately 30 seconds to 5 minutes to allow for any 
possible acid phosphatase to transfer to the paper. 


4. Mark the position of the paper on the item. 
5. Remove the filter paper. 
6. Spray or apply drop(s) of AP test reagent to the filter paper. 
7. Observe the treated filter paper for up to 60 seconds for a color change. 
8. After interpretation, mark the tested areas with results. 
9. Discard used filter paper by placing it in the biohazard trash. 


Interpretation 


Should a color reaction take place within 60 seconds, the result only indicates the possible 
presence of semen; the test is therefore a presumptive test.  


Grade the reaction according to the time it takes for the color to appear as follows: 
• 0-15 seconds:  4+ 
• 16-30 seconds: 3+ 
• 31-45 seconds: 2+ 
• 46-60 seconds: 1+ 
• No change, or color change after more than 60 seconds: negative 


A negative result indicates acid phosphatase is absent or below the detection threshold.  
 
Substrate controls may be included in body fluid identification tests as appropriate. 
 
 
7.3 Body Fluid Extraction 


Scope 


Possible body fluid stains are removed from the substrate and dissolved in PBS for testing.  The 
extract is used to collect cellular debris from a stain for spermatozoa examination and can also 
be used for p30 testing.   


Microscopic examination for spermatozoa or p30 testing may be skipped if, in the analyst’s 
opinion, consumption for these tests will reduce the potential success of subsequent DNA 
analysis.  Samples that are of limited size may be documented as Quantity Not Sufficient for 
Further Analysis (“QNS”).  Only a presumptive screening result will be reported but DNA 
analysis may be performed. 


Equipment, Materials, and Reagents 
• Microcentrifuge tube(s) 
• Forceps (optional) 
• Scalpel and/or scissors 
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• Mini-centrifuge  
• 1X PBS 
• Pipette and pipette tips 
• Ultrasonic cleaner  


Procedure 


1. Add sample to a microcentrifuge tube.  The analyst must exercise good judgment 
regarding the amount of sample to be portioned for stain extraction, providing sufficient 
sample for DNA analysis.  Stain intensity and size are a few characteristics that should 
be considered. Generally, up to approximately ¼ of a swab or up to approximately (1 
cm)2 of a stain may be consumed for this procedure.   


2. Add approximately 200 µl of 1X PBS to the sample.  More PBS may be required to 
ensure the sample is fully submerged.   


3. The extract(s) may be placed at room temperature in an ultrasonic cleaner for 5-15 
minutes.  Alternatively, the extracts may be soaked for 30 minutes - 24 hours in 
refrigerated storage. 


4. Centrifuge the extract(s) briefly.   


5. The extract, containing any cellular debris, will be used for microscopic spermatozoa 
examination and may also be used for p30 testing. 


6. Store the extract refrigerated, when necessary, for up to 24 hours.  Beyond 24 hours the 
extract should be stored frozen. 


Substrate controls may be included in body fluid identification tests as appropriate. 
 
7.4 Microscopic Spermatozoa Examination 


Scope 


Spermatozoa (sperm) detected on an evidence sample confirm the presence of semen; the test 
is therefore a confirmatory test. This procedure uses the SERI Christmas Tree Stain which is a 
Kernechtrot-Picroindigocarmine differential biological stain that assists in scanning slides for the 
presence of spermatozoa.  The test consists of a two stain method which dyes the tip of sperm 
heads pink, the bottom of sperm heads red, the tails green or blue and any epithelium green 
with red nuclei.  


Human sperm are flagellated with a total length of about 50 μm. The sperm cell head generally 
is oval, flattened at the anterior end, with dimensions about 4.6 μm x 2.6 μm x 1.5μm.  
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Identifying characteristics for spermatozoa: 


1. Size (head is approximately 4.6 μm x 2.6 μm x 1.5μm)  
2. Morphology (oval to round or teardrop-shaped structure) 
3. Acrosomal cap at tip of sperm (unstained or lightly stained) 
4. Staining (dark pink to red head, with unstained or lightly stained acrosomal cap; tails 


green or blue, if present) 
5. Presence of a flagella or tail (may not be present) 


EQUIPMENT, MATERIALS, AND REAGENTS 
• Microscope slide  
• Body fluid extract 
• Pipette and pipette tips 
• Heat block 
• Christmas Tree Stain - Solution A and Solution B  
• Timer 
• Tap water 
• 95%  ethanol 
• Compound microscope 
• Immersion oil 


Procedure 


If slide has already been prepared, proceed to step #4. 
1. Pipette 10 µl of the supernatant from the body fluid extract onto a glass slide.  Fix smear 


by heating the slide on the heat block for approximately 5 minutes. 


2. Stain the slide. 


a. Cover the sample area on the slide with Solution A for 10 minutes. 


b. Wash with tap water by gentle flooding. 


c. Cover the sample area with Solution B for 15 seconds. 


d. Wash with tap water by gentle flooding. 
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e. Flood the slide with 95% ethanol and allow the slide to dry for at least 5 minutes 
on the heat block. 


3. Examine the slide for the presence of spermatozoa at 1000X magnification.  


4. Document the approximate number of sperm seen on the slide.  Once the count 
exceeds 25 spermatozoa observed, the documented count can be “25+”, “>25”, or 
“TNTC”.  The presence of only one spermatozoon must be verified by a second qualified 
analyst who must initial and date the examination documentation.   


5. If too much cellular material and/or debris is potentially obscuring any spermatozoa on 
the slide for the analyst to make a determination about the presence or absence of 
sperm, the following procedure may be performed: 


a. Centrifuge the sample to pellet any cells. Remove and save supernatant for p30 
analysis. 


b. Wash the cell pellet 1x with 500μl of sterile diH2O or 1X PBS, pipetting the pellet 
up and down or vortexing. 


c. Centrifuge again to pellet any cells. 
d. Re-suspend in 50 to 300μl of sterile diH2O or 1X PBS, again by pipetting up and 


down or vortexing. 
a. Use the new suspension to make another slide, repeating steps 2-5.  


Examination documentation must reflect the creation of multiple slides. 
 
INTERPRETATION 
Sperm heads stain red and the tails stain green by this procedure. A minimum of one sperm 
head should be identified to confirm the presence of semen. A search of the entire slide is 
required before negative results for spermatozoa can be reported. If the slide contains too much 
cellular material or debris for the analyst to determine the presence or absence of sperm, the 
analyst may then report the result as “inconclusive”.  Alternatively, if sperm-like objects are 
observed, but one or more of the identifying characteristics are lacking, the slide may be 
reported as “inconclusive”. 


It is recommended that “inconclusive” samples proceed to DNA analysis, along with positive 
samples. 
 
7.5 SERATEC® PSA (p30) Semiquant Test 


Scope 


The cells that line the ducts of the prostate make a glycoprotein known as p30 or prostate-
specific antigen (PSA).  The protein is secreted into seminal fluid to a concentration of 
approximately 0.2 - 3.0 mg/ml, and its detection may indicate the presence of semen.  PSA may 
be found at very low concentrations in vaginal fluid (0.4-1.25 ng/ml) and is therefore a 
presumptive test. 
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The SERATEC® PSA Semiquant test is a detection method specifically designed for forensic 
identification of p30.  This test will be used qualitatively only in this laboratory.  The test is 
capable of detecting p30 in a concentration range of at least 2ng/ml - 100µg/ml PSA.   


SERATEC® PSA Semiquant test contains two monoclonal murine anti-PSA antibodies as active 
compounds.  One of these antibodies is immobilized at the test region on the membrane.  The 
upstream control region and the region of the internal standard (between control and test 
region) contain immobilized polyclonal goat anti-mouse antibodies.  The amount of antibody at 
the internal standard is adjusted to a color intensity of the line, which is equal to the color 
intensity of the test line at a PSA concentration of 4 ng/ml.  A glass fiber pad downstream of the 
membrane is used for sample loading and transmission to a second fiber pad with the dried and 
gold-labeled second monoclonal murine anti-PSA antibody.  PSA at the sample will bind to the 
remobilized gold-labeled antibody and form a PSA-gold-labeled-anti-PSA-antibody complex.   


Through the capillary effect of the membrane, the reaction mixture including the complex 
mixture is carried upwards with the fluid.  In any case, the colored gold-labeled anti-PSA-
antibody will bind to the anti-mouse-antibody at the control region and the region of the internal 
standard, thus developing two red lines (one at the control region and one at the region of the 
internal standard). These two lines are independent of the existence of PSA in the sample and 
indicate only the correct execution of the test. 


 If the sample contains PSA, the PSA-gold-labeled- anti-PSA-antibody complex will bind to the 
immobilized monoclonal antibody of the test result region that recognizes another epitope on the 
PSA molecule (sandwich complex).  The binding is indicated by the formation of an additional 
line.  Thus a PSA positive sample will show three colored lines in the result window.   


Equipment, Materials, and Reagents 
1. SERATEC® PSA Semiquant test device – one per sample  
2. Body fluid extract 
3. Pipettes and pipette tips 
4. Timer 


 
Procedure 


1. Allow previously extracted sample(s) to warm to room temperature if they have been 
refrigerated. 


2. For each sample, unwrap and label a SERATEC® PSA Semiquant test device. 
3. Add 120 μl of the supernatant to the sample well of the device. 
4. Results may be read up to 10 minutes from application of the supernatant. 
5. Record the SERATEC® PSA Semiquant test results on the Serology Results worksheet. 
6. Have a second qualified analyst examine the SERATEC® PSA Semiquant test device 


and verify the documented test result(s) by initialing and dating the appropriate Serology 
Results worksheet.    


Interpretation 


There are three lines that appear in the test device “result window”: 
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1. Control “C” line: the presence of this line confirms the integrity of the test components 
and the test procedure. It is expected for all tests and must be present. Absence of the 
“C” line is an invalid result and the test should be repeated if adequate sample remains. 


2. Internal Standard line: The intensity of this line correlates with a p30 concentration of 
approximately 4 ng/ml. It is expected for all tests and must be present. The absence of 
the internal standard line is also an invalid result and the test should be repeated if 
adequate sample remains. 


3. Test “T” line: A line indicates the presence of semen and should be documented as a 
positive result. The absence of a line or a line that appears after 10 minutes is a negative 
result or p30 concentration is below the detection limit. 


Samples that produce a negative result but show strong positive acid phosphatase activity must 
be diluted to an appropriate dilution and be re-tested  to ensure the High Dose Hook Effect is 
not occurring (see SOP #6.3 ABAcard® HemaTrace® Test Devices). 


7.6 Guidelines for Sexual Assault Cases When Contact or Digital Penetration is Alleged 


It is not possible to anticipate every situation that may arise or to prescribe a specific course of 
action for every case; therefore, the examiner must exercise good judgment based on 
experience and common sense.  The following are intended only as guidelines for cases in 
which digital penetration or other contact may have occurred.  Specific case information may 
suggest a course of action other than what is prescribed below.   


Competent (ex: can clearly recall incident): 
External swabs with clear notes on why it was collected (ex: “he kissed my breast”): 


• Bathed: NTC, add bathed statement in report 
• Not bathed: retain 


External swabs without clear notes on why it was collected (outer envelope only states 
“Breast swabs”): 


• Press-out; do not retain negatives 
Intimate swabs: 


Penile and other penetration: 
• Within 24 hours, snippet test; retain regardless of semen results 
• Beyond 24 hours, press-out; do not retain negatives 


Non-penile penetration: 
• Within 24 hours, retain 
• Beyond 24 hours, NTC 


Incompetent (ex: mentally challenged/infants/children): 
• Snippet test, retain regardless of semen results 


Unconscious (ex: doesn’t know what happened, drunk/drugged): 
• External swabs: 


o Bathed: NTC, add bathed statement in report 
o Not bathed: retain 


• Intimate swabs: 
o Press-out; do not retain negatives 
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o Unless specifically states a digital/contact situation: 
o Within 24 hours, snippet test; retain regardless of semen results 
o Beyond 24 hours, press-out; do not retain negatives 


Any information indicating that semen may be present should always be considered and 
samples processed accordingly, regardless of above guidelines (ex: “he ejaculated on my 
neck”, shorts, etc.). 
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8 Trace Collection 


8.1 Scope  


This procedure may be used when necessary for the preservation of trace evidence prior to 
forensic biology analysis.  Examples of typical trace evidence in criminal cases include 
fingerprints, glove prints, hairs, cosmetics, plant fibers, mineral fibers, synthetic fibers, glass, 
paint chips, soils, botanical materials, gunshot residue, explosives residue, and volatile 
hydrocarbons (arson evidence).  However, the reporting of trace may be limited to apparent 
hairs and fibers. 


The Locard Exchange Principle presumes that when a person comes into contact with an object 
or person, a cross-transfer of material, sometimes trace evidence, occurs.  While this laboratory 
does not currently examine trace evidence, it does make every effort to collect and preserve it 
for potential future analysis.  To do so, trace evidence is generally collected prior to the 
commencement of biological analysis. 


Dedicated trace collection room doors should remain closed at all times.  The rooms will be 
vacuumed and the floors damp mopped at least once per week when in use. Lab coats will be 
provided in the trace rooms for analysis. Lab coats used in other areas of the laboratory will not 
be taken into the trace rooms due to possible contamination. For any method used, tables and 
tools will be cleaned with bleach solution (or other lab-approved cleaning solution) before each 
use to remove any extraneous debris.  At a minimum, tools will be cleaned and new bench 
paper will be used for each item when multiple items are received packaged together. 


Generally, for any method used, a clean sheet of butcher paper will be used on the table for 
each evidence package opened.   


Evidence from victim(s) and suspect(s) will be examined in separate rooms to prevent cross 
contamination.  The examiner will change lab coats between the examination of items from 
victim(s) and suspect(s).  If separate rooms are not available, items from victim(s) and 
suspect(s) can be processed in the same room after a period of 7 days. 


8.2  Procedure 


Equipment, Materials, and Reagents 
• Butcher paper 
• Tweezers 
• Plastic zipper bags 
• Clear packing tape or trace evidence lifters  


There are several options available for ensuring that trace evidence is properly 
collected/stored/preserved.  These are as follows: 


1. Visual examination: locate and remove trace evidence from the evidence item with 
tweezers.  Recovered trace will be placed in a suitable labeled container (zipper bags or 
on tape) to prevent loss or contamination of the sample. 
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2. Tape Lifting: clear tape is pressed over the area potentially bearing trace evidence.  This 
application is repeated until all areas of interest are covered.  New tape should be used 
once the tape in current use loses its stickiness.  Tape(s) will be placed on the inside 
surface of a clean cut open zipper bag or a sheet protector.  The bag/protector will be 
labeled as to its contents. 


3. Retaining in butcher paper:  Trace evidence may also be preserved by retaining the 
evidence item in butcher paper.  The evidence item may only be opened in a clean trace 
environment to prevent contamination and/or loss. 


Place all collected trace evidence in the original evidence container with the item from which it 
was collected. 


The observation or collection of trace evidence must be documented on the appropriate 
examination documentation.  Examiners should not make any attempt to identify on their 
worksheets what was collected (i.e. hair, fiber, etc) unless they also possess current training in 
the disciplines of Trace Evidence.  However, it is permissible for sample descriptions to include 
adjectives such as “apparent” or “-like” when describing trace evidence (e.g., hair-like or 
apparent fibers). 


8.3 Reference 


1. Saferstein, R. (2007).  Criminalistics: An Introduction to Forensic Science, Ninth Edition.  
Upper Saddle River, New Jersey: Pearson/Prentice Hall. 
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9 Contact DNA Collection 


9.1 Scope  


This procedure may be used, when necessary, for the collection of contact DNA evidence prior 
to forensic biology analysis.  This laboratory does not currently “screen” for the presence of 
contact DNA through a method such as microscopic examination for the presence of epithelial 
cells.  Contact DNA is generally very limited in nature and consumption during screening may 
further reduce the potential success during DNA analysis.  For this reason, when an item is 
suspected of containing contact DNA, efforts to collect possible contact DNA will be made.  
These samples may then be submitted for DNA analysis. 


9.2 Equipment, Materials, and Reagents 
• Sterile cotton swabs 
• Sterile diH2O  
• Swab drying box (optional) 


9.3 Procedure 
1. Set the evidence onto a non-porous surface. 


2. Moisten swab(s) with sterile diH2O. 


3. Swab the suspected area(s) on the evidence with the tip(s) of the cotton swab(s).  
Efforts to concentrate the possible contact DNA on the tip of the swab should be made.  
This will hopefully serve to increase chances of DNA success not only by concentrating 
the possible DNA but also in the absence of visible staining, later portioning will more 
likely capture DNA if the correct area of the swab is selected for portioning.  As the area 
to be swabbed increases in size, so too may the number of swabs needed to adequately 
collect the evidence.     


4. Avoid any suspected semen or blood stains.  These sources of biological material 
generally contain more DNA and will potentially “mask” any lower level contact DNA.  
These stains may be processed separately.  


5. Allow swab(s) to completely dry in a swab drying box for 30 minutes.  Alternatively, the 
swab(s) may be air dried overnight in a secure location. 


Sometimes, such as in the case of fingernail scrapings and clippings, suspected bloodstains 
cannot always be avoided.  In such instances, the analyst will look for any visible red/brown 
staining and document accordingly prior to swabbing the item.  It may be appropriate to forgo 
blood or semen detection in order to maximize potential contact DNA for DNA anlaysis.  
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10 Portioning for DNA Analysis 


10.1 Scope 
After serological analysis, any evidence that will be retained in the laboratory can be portioned 
for potential DNA analysis. Please refer to SOP #5 (Evidence Evaluation and Handling) for 
guidelines on general evidence handling, and the consumption of evidence in particular.   These 
should be treated as guidelines only; good judgment and case specifics may warrant a deviation 
from what is prescribed below. 


10.2 Equipment, Materials, and Reagents 
• Scalpel or scissors 
• Microcentrifuge tube(s) 
• Weighing paper or butcher paper 


10.3 Procedure  


NOTE: Make every effort to preserve at least half of the sample for re-analysis.  If this is 
unavoidable, written permission must be obtained.     


1. Set the evidence onto paper. 


2. Portion the evidence according to the chart below: 


Swabs 
Results Portions 


P30 (+) only, no spermatozoa ~ ½ of total swab(s)  


<10 spermatozoa ~ ½ of total swab(s) 


≥ 10 spermatozoa Remainder of swab cut for p30 
or micro 


HemaTrace (+) ~ ½ remainder of swab cut for 
HemaTrace 


QNS ~ ½ of total swab(s)   


Contact ~ ½ of total swab(s) 


Bloodstain card ~ 0.5 cm 2 from center of stain 


Known saliva swabs ~ ½ of 1 swab 
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Clothing 
Results  Portions 


<10 spermatozoa or p30 (+) only ~ 1 cm 2 cutting 


≥ 10 spermatozoa ~ 0.5 cm 2 cutting 


HemaTrace (+)  ~ 0.5 – 1 cm 2 cutting 


QNS ~ ½ of the stain 


 
3. Place portion into a microcentrifuge tube. 


4. Label microcentrifuge tube with incident number, item number, and initials. 
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11      Case Records 
11.1 Examination Documentation  
The notes and other documentation must support the conclusions of the examiner. The 
laboratory report must communicate both the analytical results and the conclusions of the 
examiner, conveying the essence of what he or she would say if asked for an expert opinion in 
court.  Decisions may be made by police officers, attorneys and the courts based on the report 
alone without examiner clarification, so the report should be able to stand alone. Some case 
record requirements can be found in the Quality Manual, any additional case record 
requirements are included here. 


Documentation must be in such a form that another qualified examiner or supervisor, in the 
absence of the primary examiner, would be able to evaluate what was done, interpret the data, 
and reach a scientific conclusion.  Appropriate worksheets should be used.  


Each examination worksheet(s) should include the following: initials, incident number, controls, 
dates of analyses, item names/numbers/quantity, results, and disposition. Items that are not 
tested or opened should be described to the extent to which they can be. A written description 
may suffice for some items, whereas others may need a drawing or photograph.  Descriptions of 
evidence should be clear and sufficient to permit the later identification of an item.  They may 
include any of the following: tears, cuts, missing buttons, possible bullet holes, location, and 
length of possible stab holes, soiling condition, degree of degradation, type of material, 
significant foreign material, etc.. Significant stains must be drawn or documented in a manner 
which clearly demonstrates the location, relationship to other stains, reactions to screening 
tests, etc. Abbreviations may be used; see SOP #12 for a listing of approved abbreviations.  


If needed, the location of the substrate blank control and its relationship to the body fluid stain in 
question must be clearly documented.  The type of material or fabric the stain is on may be 
significant. 


11.2 Reports 
Report the results of any tests performed, including ALS, AP, PHT, p30, HT and microscopic 
spermatozoa examination.  If presumptive tests are positive but confirmatory tests are not 
performed, this fact should be reported.  For some items, it may be useful to report what area of 
the item was tested. Also include trace examination, whether collected or observed. Instructions 
should be included in the report as to requesting trace analysis if needed. Note if any items 
listed were not analyzed. 


It may be appropriate to include in the report a request for the submission of known samples 
from any of the following: suspects, complainants, witnesses, consensual sex partners, and/or 
other individuals for the purposes of elimination.   


Although interpretation of individual tests are discussed in the appropriate protocols, analysis 
results must be considered together to ensure that conclusions take into account all reasonable 
possibilities. During analysis, the examiner must continuously monitor results for problems and 
inconsistencies that may ultimately affect final conclusions.  Therefore, careful review of notes 
and results by the examiner should be undertaken before conclusions are drawn.  A supervisor 
or qualified examiner may assist in the developing of the appropriate conclusions. Slightly 
different situations may lead to different conclusions.  When in doubt, consult with other 
qualified examiners and/or the supervisor. 
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11.3 Examination Counts 
Information related to the number of examinations performed during each analysis can be 
documented on the “Serology Examination Count Sheet” in LIMS.  This information can be used 
by laboratory management to accurately capture metrics such as laboratory capacity, volume of 
specific requests, and sectional productivity. 
 
The following is a summary of how totals for this form should be calculated:  
 
Category How to Calculate 
Number of Items Number of items listed on the report 
ALS Exams Number of items viewed with ALS (excluding controls) 
AP Number of swabs/stains tested (excluding controls) 
Sperm searches Number of slides viewed 
p30 Number of cards tested 
PHT Number of swabs/stains tested (excluding controls) 
HemaTrace Number of cards tested 
Trace collection/observation Number of items with trace collected or trace observed 
Bloodstain cards Number of bloodstain cards made 
Swabbings/cuttings Number of cuttings or swabs collected  
Portions for DNA Number of portions created 
Total examinations Total of examinations – LIMS will calculate 
 
 
 


 








HPD Crime Laboratory  Standard Operating Procedures: Biology 
13 Chelex Extraction of DNA 


 


Unofficial Copy if Printed    Page 1 of 2   Issued by Technical Leader 
Revision Date: November 9, 2012 
Effective Date: November 26, 2012 


13 Chelex Extraction of DNA  
 
This procedure will allow for the extraction of DNA from samples containing semen.  The Chelex 
extraction is an efficient and quick method to obtain the DNA from the samples.  The addition of 
DTT will allow for the digestion of samples that contain semen.  Samples may or may not 
contain semen.   
 
Safety 
Body fluids, tissues, and extracts may contain infective agents. Use universal precautions 
during evidence handling. Follow instructions for reagent preparation. Gloves must be worn 
during testing. Clothing may protect unbroken skin; broken skin should be covered. 
 
Standards, Control, and Calibration 
One reagent blank must be processed for each extraction batch as a negative control.  
 
Please refer to SOP #5 (Evidence Evaluation and Handling) for guidelines on general evidence 
handling, and the consumption of evidence in particular. 
 
Equipment, Materials, and Reagents 


 scissors, scalpel, tweezers 


 5% Chelex 


 Proteinase K (10 mg/ml) 


 0.39 M DTT 


 tubes – 1.5 ml, microcentrifuge 


 microcentrifuge with rotor for 2 ml tubes at room temperature 


 water bath or dry bath ~56.0 °C  


 water bath or dry bath ~100.0 °C 


 vortex 


 stir plate 
 
Procedure 


Portioning 
 


A portion of all swabs provided will be taken for Chelex extraction.   
 


1. Set the evidence onto paper. 
2. Portion ~1/8 of all swabs for a particular piece of evidence. 
3. Place all portions into a microcentrifuge tube. 
4. Label microcentrifuge tube with incident number, item number, and initials. 


 
 


Chelex Extraction  
 


1. Make sure Chelex beads are evenly distributed in solution.   
a. If necessary, re-cap and mix stock by inversion periodically during processing.   
b. Alternatively, chelex solution may be made in a sterile bottle and a reagent stir 


bar used to keep the beads distributed.   
2. Add approximately 200 uL of 5% Chelex solution. 
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a. Ensure the substrate is completely saturated. Additional Chelex solution may be 
needed to completely submerge the swab. 


b. If additional Chelex is needed, the same volume must be added to reagent blank 
3. Add 10 uL of Proteinase K and 40 uL of 0.39M DTT 
4. Vortex sample for ~10 seconds.  
5. Incubate at ~56.0 °C for 30-45 minute. 
6. Vortex 
7. Incubate at ~100 °C for 8 minutes.   
8. Briefly vortex, then centrifuge the tube to pull beads to the bottom of the tube. 


a. Chelex beads and substrates should be pulled to the bottom of the tube.  If a 
supernatant layer is not visible then centrifuge again.  A higher centrifugation 
setting may be necessary.   


9. Carefully transfer ~50 uL of supernatant into a new 1.5ml microcentrifuge tube.  Be sure 
to not transfer any Chelex beads. 


a. If any of the beads are transferred, pipette the supernatant back into the Chelex 
solution.  Repeat steps 7 – 9. 


10. Store samples refrigerated or frozen until ready to perform Plexor HY analysis. 
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12  Abbreviations 
 
In addition to standard scientific abbreviations, as well as those found in the dictionary, 
the following abbreviations are defined here and acceptable for use on case work 
documentation.  Abbreviations not contained on this list must be defined on each 
examination document on which it is used. 


 
Ø none FTC found to contain PR# payroll number 
~ approximately HPS              hospital patient sticker PREP preparation 
ALS alternate light source HRS hours PT  patient 
AP acid phosphatase HT HemaTrace® Q questioned sample 


APP apparent INC inconclusive QNS quantity not sufficient 
(for further analysis) 


AR administrative review INC # Incident Number R/B             reddish/brown 
BC barcode IT item REP representative 
BSC  bloodstain card K known standard sample REC’D received 


BUC buccal KBS known buccal swabs RMS Records Management 
System 


 c                containing KSS Known saliva swabs RPR return to property room 
CAPT captain LG large S/SEC second 


COMM     communication LIMS Laboratory Information 
Management System SA              sexual assault  


COMPL complainant LT lieutenant S-CELLS sperm cells 
CONT’D continued MED medium SCRN Screening 
CS  Controlled Substances MICRO sperm search by microscopy SF sperm fraction 
CTRL control MFG manufacturer SGT sergeant 
D depleted N/A not applicable SM small 
DOB  date of birth NEG negative ST stain 
diH2O deionized water NSO no stains observed STC said to contain 
DISP disposition NTC no testing conducted SUPPL       supplement  
ECD excessive cellular debris NTO no trace observed SUSP suspect 


E-CELLS epithelial cells NSTO                no significant trace observed    SWIFS Southwestern Institute 
of Forensic Sciences 


EF epithelial fraction NVB no visible bloodstain TEMP temperature 
EMS Evidence Management System OFTC opened, found to contain TNTC too numerous to count 
ENV envelope OLO online offense system TOX Toxicology 
EtOH ethanol PBS phosphate buffered saline TR technical review 
EVID evidence PG/PP page/pages UNK unknown 
EXP expiration PHT phenolphthalein VAG vaginal 
F frozen PKGD/PKG’D packaged W/ with  
FA Firearms POS/+ positive WIF walk-in freezer 
FNS fingernail scrapings POSS possible YOA  years of age 
FNSC fingernail scrapings/clippings PR HPD Property Room   
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14 Plexor HY Quantification 
 
The Promega Plexor HY kit contains all necessary reagents for the simultaneous real-
time PCR amplification, detection, and quantification of human autosomal and human 
male DNA in a sample.  The results can be used to determine the presence of male 
DNA in samples with overwhelming female DNA.   
 
The DNA quantification assay combines three separate assays: 


 A mulitcopy human autosomal DNA assay 


 A mulitcopy human male DNA assay 


 An internal PCR control assay 
 
The kit works with the Applied Biosystems 7500 Real-Time PCR System and SDS 
Software v1.2.3 for data collection.  Data analysis is accomplished by exporting the data 
to the Plexor Analysis Software v1.5.6.7. 
 
Safety 
Body fluids, tissues, and extracts may contain infective agents.  Use universal 
precautions during evidence handling.  Follow instructions for reagent preparation.  
Gloves should be worn during testing.  Clothing may protect unbroken skin; broken skin 
should be covered.   
 
Kit Contents and Storage 
The Plexor HY kit comes in two sizes, 200 and 800 reactions with a 20 µL reaction 
volume.  Store the entire kit at -15°C to -25°C upon receipt.  Store the male genomic 
DNA standard at 2°C to 8°C after first thaw, the remaining kit should continued to be 
stored at -15°C to -25°C.   
 
 


Plexor® HY System 200 reactions  
Product Size Cat. # DC1001 
Includes: 
• 2 × 1ml  Plexor® HY 2X Master Mix 
• 200μl  Plexor® HY 20X Primer/IPC Mix 
• 150μl  Plexor® HY Male Genomic DNA Standard, 50ng/μl 
• 2 × 1.25ml  Water, Amplification Grade 
 
Plexor® HY System 800 reactions 
Product Size Cat. # DC1000 
Includes: 
• 8 × 1ml  Plexor® HY 2X Master Mix 
• 4× 200μl  Plexor® HY 20X Primer/IPC Mix 
• 3 × 150μl  Plexor® HY Male Genomic DNA Standard, 50ng/μl 
• 5 × 1.25ml  Water, Amplification Grade 
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NOTE: Keep Primer/IPC Mix and Master Mix protected from direct exposure to light.  
Excessive exposure to light may affect the fluorescent dyes. 
 


Creating a Plexor HY worksheet 
1. Open the "Plexor HY Worksheet" template (an Excel spreadsheet).   
2. Type samples into the sample sheet.  Ensure each standard is present and in 


duplicate. 
3. Print the file for documentation in the case file(s).   


 


 
 


4. Save the excel file with initials and date of run (i.e. AB092012) 
5. Close excel. 


 


 
Preparing the DNA Quantification Standards 
 
Make a standard curve dilution series consisting of: 
 


Standard ng/µL 


Male Genomic DNA Standard 50 


B 10 


C 2 


D 0.4 


E 0.08 


F 0.016 


G 0.0032 


 
To create this series of standards, perform the following tasks: 
 


1. Label 6 microcentrifuge tubes B, C, D, E, F, and G. 
2. Dispense 40 µL of TE into the six microcentrifuge tubes. 
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3. Vortex the Male Genomic DNA Standard for 3 to 5 seconds 
a. If this is the first use of the standard, thaw the DNA.  


4. Prepare Standards B through G: 
a. Pipette 10 µL of the Male Genomic DNA Standard to the tube for Standard 


B. 
b. Mix the dilution thoroughly 
c. Using a new pipette tip, add 10 µL of the prepared standard to the tube for 


the next standard (e.g. 10 µL of Standard B into the tube for Standard C; 
the resulting mixture will contain 10 µL of the previous standard and 40 µL 
of TE) 


d. Mix the dilution thoroughly 
e. Repeat steps 4c and 4d until the dilution series is complete 


 
NOTE: Any unused standard can be labeled with the analyst's initials and date of 
creation (e.g. ABC010101) and stored at 2°C to 8°C for up to two weeks. 
 
 
Reaction and Plate Setup Procedure 


1. Allow the Plexor HY kit components to thaw to room temperature.  Mix the 2X 
Master Mix and 20X Primer/IPC Mix by brief vortexing.   


2. Make a set of positive standards as described in the Previous section (entitled 
"Preparing the DNA Quantification Standards"). 


3. Prepare a Master Mix consisting of the following reagents and volumes: 
a. The “Plexor HY Worksheet” will include the necessary volumes for the 


master mix 
b. The worksheet includes a correction factor for pipetting loss 


 


Component 
Volume Per 


Reaction (µL) 


Plexor HY 2X Master Mix 11 


Plexor HY 20X Primer/IPC Mix 1.1 


Water, Amplification Grade 7.7 


   
4. Vortex the Master Mix for 3 to 5 seconds, then briefly centrifuge the tube. 
5. Dispense 18 µL of the Master Mix into each reaction well. 


a. Make sure the plate is correctly oriented, A1 will be to the top left 
6. Add 2 µL of each sample, standard, or control (TE for negative control) into the 


applicable wells.   
7. Seal the reaction plate with the adhesive cover. 
8. Centrifuge the plate at ~3000 rpm for about 20 seconds in a plate centrifuge with 


plate holders to remove any bubbles. 
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9. Load the plate into the plate holder of the 7500.  Ensure that the plate is correctly 
aligned in the holder. 
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Push the tray door to open it. 
 
 
 
 
 
 
 
 
 
 
 


 
Insert the plate into the plate holder. 


 
 
Load standard 96-well plates with the notched A12 position at the top-right of the tray. 


 
 
Close the tray door. 
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Starting the 7500 Real-Time PCR System 
Overview 
Starting the 7500 Real-Time PCR System involves: 


1. Starting the Computer, if not already on  
2. Powering on the Instrument  
3. Starting the 7500 SDS Software  


 
Starting the Computer 


1. Open the laptop computer by pushing in the front center button, holding it, 
and lifting the lid. 


2. Press the power button on the computer. 
3. Enter the username associated with the computer, if applicable. 
4. If required, type the corresponding password in the password field. 


 
NOTE: Wait for the computer to finish starting up before powering on the 7500 
instrument. 
 
Powering on the Instrument 


1. Press the power button on the lower right front of the 7500 instrument. 
2. The indicator lights on the lower left of the front panel cycle through a power on 


sequence. 
3. When the green power indicator is lit (not flashing), communication is established 


between the computer and the instrument. 
 
NOTE:  If the green power-on indicator is flashing or the red error indicator is lit, see the 
Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System Installation and 
Maintenance Guide (PN 4347828) 
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Starting the 7500 SDS Software 


1. Start the 7500 System Software. Double click on the software icon. 


2.  
3. The software starts and displays the word "Disconnected" in the status bar on the 


bottom-right corner.  The status changes to "Connected" only after the New 
Document Wizard is completed, the software is initialized, and the software is 
connected to the 7500 instrument.  If the connection is successful, the software 
displays “Connected” in the status bar on the bottom-right corner. 


 
Creating a Plate Document and Starting the Run 


1. Click File > New 
2. Click Browse below the Template box. 


 
3. Navigate to the Desktop and select the “Plexor HY” template 
4. Click Open (or double-click the template file) 


 
NOTE:  The following box will appear any time you open, close, save, or analyze 
the file. Always click yes to navigate pass the box.   
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5. Click File > Save As 
6. Name run with initials and date (i.e. AB092012) 
7. Save the file to the Desktop 
8. Click on the Instruments tab and click Start to start the run. 


 
9. Ensure that the Estimated Time Remaining shows a time before leaving the 


room.  
 
 
Analyzing run and Exporting files with 7500 SDS Software 


1. When the run is complete the instrument will display a successful run completion 
message. 


2. Click okay 
3. Omitting unused wells 


a. Select the unused wells according to your worksheet. 
b. With the well selected, hit Ctrl + M 
c. The omitted wells will now show an “X” through them 


4. On the menu bar, select Analysis > Analyze. 
a. Alternatively the green arrow in the menu can be clicked 


 


 
 


5. Exporting Files 
a. Select File > Export > Delta Rn 
b. Save the file with the run name and the suffix “-delta” (i.e. AB092012-


delta) 
i. Save the file to the Desktop with the run file 


c. Select File > Export > Dissociation > Raw & Derivative data  
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d. Save the file with the run name and the suffix “-diss” (i.e. AB092012-diss) 
i. Save the file to the Desktop with the run file 


e. Do NOT open the export files.  This will corrupt them for later use. 
6. Close the 7500 run file and 7500 SDS software 


a. Click Yes to Save if prompted to do so. 
7. Move the three saved files to the appropriate month and year folder of  


\\travfs01\CrimeLab\SHARED\BiologyInstruments\7500PCR\Plexor HY 
8. Remove and discard the plate from the 7500 
9. Turn off the 7500 


 
Plexor HY Analysis software 
Note: The following instructions are suitable on software that has been appropriately 
initialized 
 
Software set up and file import 


1. Start the Plexor Analysis Software 
2. Select File > Import New Run 
3. Fill in the Assay Name with the same name as the 7500 run file (i.e. AB092012) 
4. Make sure that the instrument is set to Applied Biosystems 7500 SDS v1.4 & 


prior 
5. Click Next 
6. Fill in the Operator Name, initials are acceptable 


a. The remaining fields can be left blank 
7. Click Next 
8. Click the upper Browse button to add the Amplification file 
9. Navigate to the previously saved “Delta Rn” file (i.e. AB092012-delta) 
10. Select file and click open 
11. Click the lower Browse button to add the Melt file 
12. Navigate to the previously saved “Raw & Derivative data” file (i.e. AB092012-


diss) 
13. Select file and click open 
14. Under the Advanced Options 


a. Click Edit under Analysis Template 
b. Select Defaults > Reset to Default 
c. Click OK 
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15. Click Finish 
16. A window will appear with the run data 


 
Data Analysis and Report Generation 


1. Make sure the FL-Autosomal Tab is selected 
2. With all samples selected, go to Edit > Add Standard Curve 


a. Alternatively you can hit the “d” key 
3. Select the CO560-Y Tab 
4. With all samples selected, go to Edit > Add Standard Curve 


a. Alternatively you can hit the “d” key 
5. Select the Sample Names Tab 


a. Open the Excel Plexor HY worksheet saved previously 
b. Select and Copy the wells that were used for the run 
c. Return to the Plexor Analysis software 


6. Select Edit > Paste Sample Names from Template 
a. Alternatively you can hit the “Ctrl + t” key 


7. Click Accept Changes in the bottom right of the window 
8. Select Forensics > Set Normalization and IPC parameters 


a. Do not change any settings 
9. Click Ok on the window that pops up 


a. Give the software a minute and the window will change to the Forensic 
report tab under the Reports tab 


10. Check that the first location is A1.  If not click Location until it is. 
a. Click on Location so the samples will be sorted by location 


11. Select File > Save Analysis File 
12. Title the file with initials and run date (i.e. AB092412) 
13. Save the file to 


\\travfs01\CrimeLab\SHARED\BiologyInstruments\7500PCR\Plexor HY 
 
Data interpretation 
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1. Standard Curves Evaluation 
a. Under the “Standard Curves” tab 


i. Click on the “FL-Autosomal” tab 
1. The Autosomal curve, the slope must be between -3.1 to -


3.7 and R2 ≥ 0.990 
ii. Click on the “CO560-Y” tab 


1. The Y curve, the slope must be between -3.0 to -3.6 and R2 
≥ 0.990 


 
NOTE: A limited number of outlier points may be omitted from the curve to bring these 
values within acceptable range.  If these values are not within range, the procedure must 
be re-run.  Removal of more than 3 data points must be approved by the Technical 
Leader.  Points can be removed by changing the sample type under the “PCR Curves” 
tab.  Refer to Plexor HY manual for more detail. 
 


2. Click back to the “Reports” tab, and select the “Forensic” tab. 
3. Check that the IPC Status column is “OK” for all samples. 


 
NOTE: A higher value indicates the presence of inhibitors.  The absence of an 
IPC value and a quantification value for a sample indicates either complete 
inhibition or a failure of the amplification reaction.  If necessary a dilution may be 
made and run again with Plexor HY.  A dilution which would theoretically contain 
fewer inhibitors may be quantified. 


 
4. Check that the Curve Status column is “OK” for all samples. 


a. Depending on sample type (standard, non-template control, or sample) 
three other options may be displayed depending on sample type 


i. Check STD – displayed for samples designated as standard 
controls  


ii. Check NTC – displayed for samples designated as non-template 
controls 


iii. Check Melts – displayed for sample designated as unknowns  
 


NOTE: “Check” messages will only be displayed on samples that have 
concentration values.  The message indicates that the melt curve needs to be 
assessed for that sample. 
 


b. Examine the melt curves for samples that are NOT “OK”.   
i. Melt curves need to be assessed for both Autosomal and Y results. 


c. Melt curves can be examined under the “PCR Curves” tab.  The melt 
curve is the bottom graph 
 


NOTE: Melt curves are a measure of the PCR products produced during 
amplification.  If a sample has a low level DNA concentration, but no melt curve, 
then the detected fluorescence is most likely from non-specific fluorescence and 
not from amplifiable DNA.   
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d. When examining the melt curves in the “PCR Curves” tab three different 


calls are available in the “Tm?” column on the right side 
i. Yes – the melt curve is within the designated range  
ii. No – the melt curve is not within the designated range 
iii. No Call – the melt curve is within the designated range, but there is 


insufficient amplification product to cross the threshold 
e. Documentation of why melt curves were not “OK” will need to be made on 


the report print out.   
 


5. Return to the “Forensic” tab under the “Reports” tab 
6. Check that all negative controls (including reagent blanks) have less than 5 x 10-3 


(0.005) ng/µl of detectable DNA present.  If negative control values exceed 0.005 
ng/ul, then consult with the Technical Leader on available options.   


7. Close the Plexor run file by File > Close Current Analysis. 
a. Alternatively you can click the red X in the upper right run file window.  


This is just above the printer icon.   
8. Save results if asked to do so. 
9. Reopen the file by File > Open Analysis File 


a. Alternatively you can click the file icon in the menu bar  
10. Navigate to the saved file and select it.  Click Open 
11. Return to the “Forensic” tab under the  “Reports” tab if not already there 
12. Make sure all samples are selected. All samples will be highlighted blue. 


a. All samples can be selected by clicking one sample and hitting Ctrl + A 


13. Select the print  icon    on the right  
14. Under Page Setup, change the orientation to Portrait 
15. Click Print 
16. Close the Plexor run file and software. 


a. Save any changes if prompted to do so 
17. Add any comments to the report that are necessary.  Examples include: 


a. If any points were dropped from the standard curve. 
b. Results of melt curve investigations 


18. Place a copy of the report containing the results in the case file. 
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